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Write:OutLoud®

Chapter 1
The Toolbar

Write:OutLoud is a talking word processor that is filled with features that increase its
ease of use.  Many functions can be carried out by simply clicking the toolbar at the
top of Write:OutLoud window.  This section helps you understand the features unique
to Write:OutLoud, including navigating through text, speech options, spell checker
and more.

Unique Talking Toolbar Features

When you launch Write:OutLoud, you’re ready to type and create documents
immediately.  The Write:OutLoud toolbar gives you one-click access to common tasks.

The buttons on the toolbar are grouped according to tasks for easier use.
It’s also a talking toolbar.  To hear a button speak its function, place the mouse pointer
over the button.  Windows users, click the Right Mouse button.  Macintosh users,
speech is automatic after your cursor stays on a button for a second or two.  Also, a
label that lists the button name pops up from the button.

Tip:  If you do not want to hear the buttons speak their functions, turn Speak
Toolbar off in the Options menu.

A label pops up
after the cursor
dwells on a button

A description
of what the
button does
is shown in
the status bar

Navigation Speech
File

Management AppearanceContent
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To try all the features you can access from the toolbar, type a few sentences in the
Write:OutLoud window.  You hear Write:OutLoud speak as you go.  At the end of the
sentence, it speaks the entire sentence, highlighting each word as it reads.

Note:  See Appendix A for a complete listing of key equivalents for toolbar functions.

If you do not want to see the toolbar display, select Hide Toolbar from the Options
menu.

Write:OutLoud
document with toolbar
hidden
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Text Navigation and Selection Buttons

Tools for text navigation and selection help students quickly and efficiently move
through and review their writing.  Write:OutLoud includes four in the toolbar.

These tools are especially helpful for students with poor visual and/or motor
skills.  There are many more keyboard shortcuts for text navigation and
selection; see Appendix A for a complete list.

Beginning

To move your cursor quickly to the start of the document, move your mouse pointer to
the toolbar and click Beginning.  The cursor moves to the beginning of your text entry.

Students can quickly get back to the beginning of the document to add a title or reread
the story.

Move

To move your cursor to the next sentence, click Move.  The cursor moves to the
beginning of the next sentence.  A sentence must end with a period, question mark or
exclamation mark in order for Write:OutLoud to recognize it as a sentence.

Students can quickly navigate through their document for reading and revising the
story.

Select

Move cursor
to beginning
of document

Move cursor
to next
sentence

Select
next
sentence

Move cursor
to end of
document
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To highlight the next sentence, click Select.  With the sentence highlighted, you can
click Speak, Grow or Shrink Selection.  If your cursor is in the middle of a sentence,
Select highlights words from the cursor to the end of the sentence.

Students can quickly select “chunks” of text for reading aloud, revising or formatting,
sentence-by-sentence.

End

To move directly to the end of the document, click End.  The cursor moves to the end
of your document.

Students can quickly get to the end of the document to add to existing work.
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Speech Buttons

Speech feedback is important for writing success because it gives students immediate
aural reinforcement of what they just typed.  It gives students the opportunity to self-
correct based on what they hear.  Write:OutLoud includes three basic speech tools.

Speak

Click Speak to hear the sentence.  Write:OutLoud speaks the selected text or the
sentence containing the cursor.

Click Speak again and the next sentence is spoken.  With this feature, you can move
through your entire document sentence-by-sentence, speaking each as you go.

To speak specific words or sentences, highlight the text first, then click Speak.

To speak the entire document, choose Select All in the Edit menu and click Speak.

Note:  For speaking, sentences are spoken until sentence-ending punctuation or new
paragraphs are encountered.

Students can control reading of their document for comprehension or revision.

Tip:  For story narration, the user can speak the document sentence-by-
sentence and have control over the rate of storytelling.  Place the cursor at the
beginning of the file.  Click Speak and the first sentence speaks.  The cursor
advances to the next sentence.  Click Speak when ready.  For smoother
delivery, turn off Highlight Word by Word in the Speech menu.

Speak
sentence or
selection

Repeat

Stop
speaking
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Repeat

Click Repeat to hear again what was just spoken.

Students can repeat what was just heard to increase comprehension or when
proofreading their work.

Stop

Click Stop to stop the current speech.

Students can immediately interrupt speech for any reason:  to revise their work, work
quietly, end a work session, make a different selection, etc.

Write:OutLoud includes many more speech options that you can turn on and off
to meet students’ needs.  See Chapter 3, The Menus, for more information.

File Management Buttons

It’s important for students to feel in control of common tasks.  Our Save and Print One
buttons give them easy access to these functions.

Save

Click Save to save your file to disk.  The first time you save it, give it a name.  This
function is the same as selecting Save in the File menu.

Use Save frequently while you’re working to save changes to the document.

Print One

Print One automatically prints one copy of your document, bypassing the regular print
dialog.  Click Print One to send the document to the printer.  Print One gives students
simplified access to printing—there are no additional windows to navigate through.

Save Print
One
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Content Buttons

Students who struggle with writing often don’t write very much text because of poor
vocabulary, spelling or organization.  Write:OutLoud’s Content features help students
with editing for mechanics, revising with better words and using pictures to support
their content.

Check Spelling

Click Check Spelling from anywhere in the document to begin the Franklin Spell
Checker.  Write:OutLoud always checks the entire document for spelling errors.

Write:OutLoud displays the Spelling dialog when it finds a word that is not in either the
regular Franklin or user dictionaries.

The spell checker displays the sentence containing the unknown or misspelled word
(highlighted) along with suggested known or correct words.  Write:OutLoud makes the
spell checker talk so you can hear the word in question spelled out and spoken in
context and to hear other suggestions in its place.  If the word in question is really a
correct word or proper name, you can add it to the WOL User Dictionary by clicking
Learn.

When you are finished with the spell checker and want to return to the document, click
OK.  All spelling changes are in the document.

For more information on using the spell checker, Chapter 4, Write:OutLoud’s Talking
Spell Checker and Talking Dictionary.

Check
dictionary

Add
Picture

Check
spelling

Speak the
sentence and
the word in
question

When checked, words in question and suggested
words are also spelled out, letter-by-letter

Change word in question to the
word in the Change to field

Add the highlighted word to
the WOL User Dictionary

Stop speaking

Return to the document

Speak
suggested word

Continue the spell check without
changing the current word
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Check Dictionary

Check word meanings with the Franklin Dictionary and Homonym Checker.  Select the
word you want to check and click Check Dictionary.  If you don’t select a word,
Write:OutLoud checks the word you just finished typing.

Write:OutLoud displays the Franklin Dictionary and Homonym Checker with the
sentence that includes the word you are checking in the first window.  The word
meanings are displayed in the second window and homonyms or confusables, if any,
are in the third window.

Use the dictionary to hear the word in question spelled out and spoken in context and
to read and/or hear its definition.  If the definition does not match the word you want,
you can consider the other words with similar spellings or pronunciations that are
frequently confused with it.

When you are finished with the dictionary and want to return to the document, click
OK.  All word changes are in the document.

For more information on using the dictionary, see Chapter 4, Write:OutLoud’s Talking
Spell Checker and Talking Dictionary.

Tip for writers using alternate access:  There are keyboard shortcuts for using
the Spelling and Dictionary dialogs.  See Appendix A for a complete list.

Speak the
sentence and
the word in
question

When checked, words in question
and suggested words are also
spelled out, letter-by-letter

Change word in question to the
word in the Change to field

Go to the next word in question
without changing the current word

Stop speaking

Return to the document

Speak
definition(s) of
the word in the
Change to field

Speak the word
and short
definition of the
word in the
Change to field

Select another word to see its definition
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Add Picture

Students can enhance the meaning of their writing by adding illustrations or
photographs to their documents.  Write:OutLoud includes a library of sample pictures,
and also supports other pictures that are Bitmaps (BMP), PICT or JPEG files.  To place
a picture in your Write:OutLoud document, click Add Picture.

Write:OutLoud sample pictures are organized by categories and kept in folders.  Open
the folder/category you want.

The list of pictures appears.  A preview of the highlighted picture is shown next to
the list.

Use the scroll bars to view other pictures in the folder.  If you want to look in a
different folder, double-click the arrow at the top of the list to go back one level in the
Write:OutLoud Pictures folder.

Picture will be added
after this point

Double-click
arrow at the
top of the list
to go back a
level in the file
directory

Use the scroll bars to move up
and down the list of pictures in
the folder

Preview of the
highlighted picture

To add a picture that is not in the
Write:OutLoud Pictures folder,
click Other… to locate it

Double-click a
folder or press
r to see
the list of
pictures in the
selected
category
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When you find the picture you want, click OK.

The picture is inserted into your document.

Once the picture is added to your document, you can move it around or change its
alignment.  You can change its size and line spacing, too, if desired.

See Chapter 5, Adding Pictures to Documents, for more information on how to use
pictures with Write:OutLoud.

Put the selected picture
into your document

Return to the document
without any pictures

Write:OutLoud automatically
puts the picture in a new
paragraph, with one blank line
before and after the picture

After a picture
is inserted, the
cursor advances
to the next line
for more typing
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Appearance Buttons

Write:OutLoud’s Appearance buttons let students change the way their document looks
because they can see the tools and use them more easily than “hidden” menu items or
commands.  These tools give students control over font size and color, too.

Grow & Shrink

 Click Grow or Shrink to change the font or picture size.  Highlight letters, words,
sentences or pictures.  Click Grow to increase the size.  Click Shrink to decrease the
size.  Each time you click Grow or Shrink, the font will change to the next available font
size.  Pictures will automatically change size by 10%.  Continue clicking until you get
the size you want.

To change the size of the next text typed, click Grow or Shrink.  Then type your
next word.  The size is changed.

Note:  Because no text was selected, if you reposition the cursor before typing the next
word, the change is cancelled.

To change the size of a section of your document, highlight the part(s) you want
to change, then click Grow or Shrink until the text is the size you want.

To resize the entire document, select all (Edit menu) and click Grow or Shrink
until the text is the size you want.

Grow

Shrink Alignment Background color

Text color
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Alignment

Choose how to align each paragraph:  left, centered or right.  Put the cursor in the
paragraph you want to change.  Each time you click Alignment, you cycle through the
alignment options of Align Left, Align Center and Align Right.  Continue clicking to cycle
through the alignment options.

To change the current paragraph, click Alignment until you get the alignment
you want.

To change the next paragraph, press r to start a new paragraph, then click
Alignment until the cursor indicates the alignment you want.  Begin typing.

To change a section of your document, highlight the part(s) you want to change,
then click Alignment until you get the alignment you want.

To change the entire document to the same alignment, select all (Edit menu)
and click Alignment until you get the alignment you want.

Background Color

Click Background Color to change the color of the entire document background.  Each
time you click this button, it cycles to the next available background color.  Continue
clicking to cycle through the color options.

Text Color

Change the color of the text.  Select the word or words you want to change and click
Text Color.  Each time you click Text Color, it cycles to the next available text color.
Continue clicking to cycle through the color options.

To change the color of the next text typed, click Text Color until the Text Color
button displays the color you want the text to be.  Then type to see the new text color.

Note:  Because nothing was selected, if you reposition the cursor before typing the
next word, the change is cancelled.

To change the text color of a section of your document, highlight the part(s)
you want to change, then click Text Color until the text is the color you want.

To change the text color of the entire document, select all (Edit menu) and click
Text Color until the text is the color you want.

Tip:  You can set the text, background and highlight colors for the document all
at once by choosing Set Colors… in the Options menu.  See Chapter 3, Using
the Menus, for more information.
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Chapter 2
The Menus

Besides using the toolbar to quickly access several functions,  you can also use
Write:OutLoud’s pull-down menus to access all functions and settings.  This chapter
describes all menu items and how to use them.

Note:  See Appendix A for a complete listing of key equivalents for menu functions.

File Menu

Windows Macintosh

The File menu includes standard items for file management.  Some of these functions
are also available in the toolbar.

New

Create a new document.  The new document will use the current default settings.

Open…

Open an existing document.  Write:OutLoud displays a standard file directory window.

Write:OutLoud can also open and read text files that are scanned in, created in other
applications or downloaded from the Internet.

Close

Close the current document.

Use the popup menu to view a different file
type:  Write:OutLoud files, text file or all files.
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Save

Save changes to document and continue working.  If the document is untitled, the
standard Save window comes up so you can give it a name.  Works exactly like the Save
button in the toolbar.

Save As…

Save document with a new name and continue working.  Or, you can save your
document as a Text file to import it into another application.  The original document
remains intact.

Page Setup

Sets the page margins and measurement system for the current document.

Tip:  Write:OutLoud automatically sets 1-inch margins for each side of the
document.  If you want your documents to have a different default setting,
make changes here, then use Save As Default in the Options menu to keep
those settings for all new documents.

Use the popup menu to save
as a different file format

Use the popup menu to save as
a different file format

Highlight the
margin you
want to change
and type in the
value

Choose the measurement system you
want to use

Reset margins to the default values:
1-inch for each side

Return to the document
with the changes

Return to the document
without changes

Or, click arrows
to incrementally
increase or
decrease the
margin
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Print Setup (Macintosh Only)
The Print Setup dialog lets you choose the printer, paper size, paper source and
orientation.  Appearance of the dialog will vary, depending on the operating system and
print driver you use.

Print One

This skips the traditional dialog and directly prints one copy of the document.  This is
easy to use because it eliminates a step.  Works exactly like the Print One button in
the toolbar.

Print…

Choose print specifications from the print window and send document to the printer.
You can print documents in color if you have a color printer.

Recent Files List

This section of the File menu can show up to four of the most recently used files.

Students can easily pull up their most recent files to resume working.

Exit or Quit

Quit the Write:OutLoud application.  The program prompts you to save your work if
you have not done so.

List of up to four most recently-used files.
Highlight the file you want to open
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Edit Menu

Windows Macintosh

The Edit menu contains standard commands for document editing, including spell
checker and dictionary.  In addition, this menu has commands for document
navigation and selection.

Undo/Redo

Undo cancels your last action.  If your “undone” action can be repeated, Undo changes
to Redo.  This item is unavailable if your last action cannot be undone or redone.

Cut

Remove selection from document.  Cut may be used with Paste.

Students can use Cut to move or remove sections of their document during the revision
stages of the writing process.

Copy

Duplicate selection.  Copy may be used with Paste.

Students can use Copy to “try out” a section of their document in a different part of the
document while they’re revising text.  If they like the change, they can Clear or Cut the
duplicate passage.

Paste

Place cut or copied selection in your document at the cursor.

Students can use Paste to move sections or add duplicate sections of the document
during the revision stages of the writing process.

Clear

Remove selection from document.  Not used with Paste.
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Select All

Highlight all text and pictures in the document.

With Select All, students can easily make global changes to paragraph alignment, font
size or color.

Find…

Locate a specific word or group of words in text.  Write:OutLoud displays the Find
dialog.  To move the dialog, drag the title bar.

During the revision stages of writing, students can search their document for items they
want to change or correct.  This feature is very helpful when students are looking at a
printed draft of their document.

Tip for writers using alternate access:  There are keyboard shortcuts for using
the Find dialog.  See Appendix A for a complete list.

Check Spelling…

Select Check Spelling from anywhere in the document to begin the Franklin Spell
Checker.  Works exactly like the Check Spelling button in the toolbar.

Write:OutLoud always checks the entire document for spelling errors.  Write:OutLoud
displays the Spelling dialog when it finds a word that is not in either the regular
Franklin or WOL User dictionaries.

Type the word
or phrase you
want to find

Displays the
found phrase in
context

Speak the sentence
and word found

Speak the word or
phrase to be found

Stop speaking

Click to find the
next instance of
the word or
phrase

Click OK when you are
done

Speak the
sentence and
the word in
question

When checked, words in question and suggested
words are also spelled out, letter-by-letter

Change word in question to the
word in the Change to field

Add the highlighted word to
the WOL User Dictionary

Stop speaking

Return to the document

Speak
suggested word

Continue the spell check without
changing the current word
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The sentence containing the unknown or misspelled word (highlighted) is displayed,
along with suggested known or correct words.  Use the spell checker to hear the word
in question spelled out and spoken in context and to hear other suggestions in its
place.  If the word in question is really a correct word or proper name, you can add it
to the WOL User Dictionary by clicking Learn.

When you are finished with the spell checker and want to return to the document, click
OK.  All spelling changes are in the document.

For more information on using the spell checker, see Chapter 4, Write:OutLoud’s
Talking Spell Checker and Talking Dictionary.

Check Dictionary…

Check word meanings with the Franklin Dictionary and Homonym Checker.  Works
exactly like the Check Dictionary button in the toolbar.

Select the word you want to check and click Check Dictionary.  If you don’t select a
word, Write:OutLoud checks the word you just finished typing.

Write:OutLoud displays the Franklin Dictionary and Homonym Checker with the
sentence that includes the word you are checking in the first window.  The word
meanings for the word in question are displayed in the second window and homonyms
or confusables, if any, are displayed in the third window.

Use the dictionary to hear the word in question spelled out and spoken in context and
to read and/or hear its definition.  If the definition does not match the word you want,
you can consider the other words with similar spellings or pronunciations that are
frequently confused with it.

When you are finished with the dictionary and want to return to the document, click
OK.  All word changes are in the document.

For more information on using the dictionary, see Chapter 4, Write:OutLoud’s Talking
Spell Checker and Talking Dictionary.

Speak the
sentence and
the word in
question

When checked, words in question
and suggested words are also
spelled out, letter-by-letter

Change word in question to the
word in the Change to field

Go to the next word in question
without changing the current word

Stop speaking

Return to the document

Speak
definition(s) of
the word in the
Change to field

Speak the word
and short
definition of the
word in the
Change to field

Select another word to see its definition
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Cue Misspelling…

Change the settings for misspelling cues.  Write:OutLoud monitors your words as you
type.  If you type a word it doesn’t recognize, it cues you with a sound (auditory)
and/or menu bar flash (visual).

Choose any combination of cueing that you desire, or turn both off.

Change the Audio Cue

To see a list of available sounds, click the ellipsis symbol next to the Audio Cue field.
Use the standard file directory window to select the sound file you want to cue
misspelling.  Or click Cancel to keep the current sound file for audio cueing.

Click OK when the settings are as you wish.  Click Cancel to return to the document
without making changes to settings.

Add Your Own Sound for the Audio Cue

If you have a different sound that you want to use for the Audio Cue, just copy the
sound file into the Sounds folder in the WriteOutLoud folder.  Then select Cue
Misspelling and click the ellipsis symbol to select your sound file.  Write:OutLoud will
now use your sound for the audio cue.

Add Picture…

Initiate the Add Picture feature.  Works exactly like the Add Picture button in the
toolbar.

To place a picture in your Write:OutLoud document, select Add Picture.

Write:OutLoud includes a library of sample pictures, and also supports other pictures
that are Bitmaps (BMP), PICT or JPEG files.  Write:OutLoud pictures are organized by
categories and kept in folders.  Open the folder/category you want.
The list of pictures appears.  A preview of the highlighted picture is shown next to the
list.  Use the scroll bars to view other pictures in the folder.  If you want to look in a
different folder, double-click the arrow at the top of the list to go back one level in the
Write:OutLoud Pictures folder.

To add a picture that is not in the
Write:OutLoud Pictures folder,
click Other… to locate it

Double-click a
folder or press
r to see
the list of
pictures in the
category

Click the ellipsis to see a
list of available sounds

Click to check
or uncheck
cueing options

Return to document
with changes

Return to document
without changes

File name of
sound selected
for audio cue
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When you find the picture you want, click OK or press «r to accept it.

The picture is inserted into your document.

Once the picture is added to your document, you can move it around or change its
alignment.  You can change its size and line spacing, too, if desired.

See Chapter 5, Adding Pictures to Documents, for more information on how to use
pictures with Write:OutLoud.

Move to Beginning of Document

Move the cursor to the top of the first page of the document.  Works exactly like the
Beginning button in the toolbar.

Students can quickly get back to the beginning of the document to add a title or start
reviewing the Write:OutLoud document from the beginning of the story.

Double-click
arrow at the
top of the list
to go back a
level in the file
directory

Use the scroll bars to
move up and down the list
of pictures in the folder

Put the selected picture
into your document

Return to the document
without any pictures

Write:OutLoud automatically
puts the picture in a new
paragraph, with one blank line
before and after the picture

After a picture
is inserted, the
cursor advances
to the next line
for more typing
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Move to Next Sentence

Move the cursor to the beginning of the next sentence.  Works exactly like the Next
button in the toolbar.  Write:OutLoud knows a new sentence usually begins after a
period, question mark or exclamation point.

Students can quickly navigate through their document for reading and revising
the story.

Select Sentence

Highlight the next sentence.  Works exactly like the Select button in the toolbar.  If the
cursor is at the end of a sentence, it highlights the whole next sentence.  If the cursor is
in a sentence, it highlights from the insertion point to the end of the sentence.  Use this
to speak or modify selected sentences.

Students can quickly select “chunks” of text for formatting or reading aloud, sentence-
by-sentence.

Move to End of Document

Move the cursor to the bottom of the last page of the document.  Works exactly like the
End button in the toolbar.

Students can quickly get to the end of the document to add to existing work.
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Text Menu

Windows Macintosh

The Text menu lets you make changes to the font, size and style of text in your
document.  You decide what parts of the document to change.

How Text Options Work

To change the next text typed, make the desired changes to font, size and style.
Then type to see the changes.

Note:  Because no text was selected, if you reposition the cursor before typing the next
word, the change is cancelled.

Tip:  To hold the “changed” style without typing words, type x after
making your style selections.  Then you can reposition the cursor without the
changes being cancelled.  When you come back and type additional information
on the line, the changes are still active.  This is a useful technique when
creating online quizzes or worksheets in Write:OutLoud.

To change a section of your document, highlight the part(s) you want to change,
then make the desired changes to font, size and style.  The selected text will change to
the settings selected.

To change the entire document, select all (Edit menu) and make the desired
changes to font, size and style.  The entire document will change to the settings
selected.
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Font

When opened, the Font dialog allows you to choose the font, the style and size of text
for your document or text selection.  See  How Text Options Work, page 61.

Windows dialog

Macintosh dialog

Click on the font, style or point size to select it.  The highlighted area is the current
setting.  The sample box will show you what it will look like.  You may select letters,
words, sentences or the entire file and change the font, style or size.  Apply different
styles for visual needs or to emphasize text.

Grow Selection

Choose Grow Selection to increase the size of all words you have selected.  Works
exactly like the Grow button in the toolbar.  If nothing is selected, the next letters you
type will be larger.  See  How Text Options Work, page 61.

Tip:  You can also use Grow Selection to resize a picture you’ve added to your
document.  Just select the picture, then select Grow Selection (or click the
Grow button in the toolbar).  The picture will automatically increase in size by
10%.  Continue until the picture is the size you want.

Use the scroll
field to select
a different
font Use the scroll field to select a different

style:  Regular, Italic, Bold or Bold Italic

Click to check
or uncheck if
you want the
text underlined

Return to the document
with the selected changes

Return to the document
with no changes

Write:OutLoud displays sample text with
the selected font, size and style attributes

Use the scroll field to
select a different size

Use the popup
menu to select
a different font

Use the popup
menu to select a
different style:
Regular, Regular
Italic, Bold or
Bold Italic

Click to check or
uncheck if you
want the text
underlined

Return to the document with the
selected changes

Return to the document
with no changes

Write:OutLoud displays sample text
with the selected font, size and style
attributes

Use the popup menu to
select a different size
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Shrink Selection

Choose Shrink Selection to decrease the font size of all the words you have selected.
Works exactly like the Shrink button in the toolbar.  If nothing is selected, the next
letters you type will be smaller.  See  How Text Options Work, page 61.

Note: The minimum font size for Write:OutLoud is 4 point.

Tip:  You can also use Shrink Selection to resize a picture you’ve added to your
document.  Just select the picture, then select Shrink Selection (or click the
Shrink button in the toolbar).  The picture will automatically decrease in size by
10%.  Continue until the picture is the size you want.

Regular

When you choose Regular, all other styles are automatically turned off.  See  How Text
Options Work, page 61.

Bold

Choose Bold to make the selected word(s) display in the bold version of the selected
font.  If no words are highlighted, the style applies to the next words typed.  See  How
Text Options Work, page 61.

Italic

Choose Italic to make the selected word(s) display in the italic version of the selected
font.  If no words are highlighted, the style applies to the next words typed.  See  How
Text Options Work, page 61.

Underline

Choose Underline to make the selected word(s) underlined.  If no words are
highlighted, the style applies to the next words typed.  See  How Text Options Work,
page 61.
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Options Menu

Windows Macintosh

The Options menu includes features that affect how your document looks:  colors,
alignment, line spacing, how your toolbar looks and acts and whether or not you want
to see page breaks.  This menu also includes the Save As Default option that lets you
change settings for all new documents created.

Hide/Show Toolbar

Hides or shows the toolbar at the top of the document.

Older students might want to hide the toolbar to make the document window look
more age-appropriate or for class presentations.

Speak Toolbar

When checked, toolbar buttons say their names when they are clicked with the Right
Mouse button (Windows) or when the cursor dwells over a button for a second or two
(Macintosh).  Select Speak Toolbar to uncheck and turn off toolbar speech.

Set Colors…

The Set Colors dialog lets you change the color of the text, background and highlight in
one convenient place.  Background and highlight color are global settings that affect
your entire document.  But you can change text colors for each word, sentence or
section of your document if you like.

To change the text color of the next text typed, just select Set Colors… with no
text highlighted.

To change the text color of a section of your document, highlight the part(s)
you want to change, then select Set Colors….

To change the text color of the entire document, select all (Edit menu), then Set
Colors….
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The  Set Colors window is displayed.  Select Text Color, Background Color or Highlight
Color and choose the color you want for each.

As you make color selections, the Sample field previews the changes so you can see
how the colors work together.  Click OK after selecting the desired color(s).

Note:  In most cases, Write:OutLoud will not allow you to select a color that is already
in use by another color attribute.  For instance, if your text color is pink, you cannot
select pink as the highlight color or background color.

Tip:  For best visibility, choose a combination that has good contrast between
text, background and highlight colors.  You may want to experiment with
several text and background colors to find a combination that works well for
you.

Align Left

Line up your text on the left with a ragged right side.  This is how text usually appears.
Change this setting by selecting another alignment option.  See  How Alignment
Works, next page.

Align Center

Line up your text in the center of the page.  This is useful for titles, etc.  Change this
setting by selecting another alignment option.  See  How Alignment Works, next page.

Align Right

Line up your text on the right with a ragged left side.  Change this setting by selecting
another alignment option.  See  How Alignment Works, next page.

Click the color you want
for the selected item

Click the radio
button of the
color you want
to change

Return to the document with the
selected changes

Return to the document
with no changes

Write:OutLoud
displays sample
text with the
selected text,
background and
highlight colors
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How Alignment Works

Each paragraph can have its own alignment.

To change the current paragraph, select the alignment option you want.  The
current paragraph will reflect the change.

To change the next paragraph, press r to start a new paragraph, then select
the alignment option you want.  Begin typing to see the change.

To change a section of your document, highlight the part(s) you want to change,
then select the alignment option you want.

To change the entire document to the same alignment, select all (Edit menu),
then select the alignment option you want.

This student chose Align
Right for his name and
grade

The picture and title
information is centered on
the page with Align Center

The body of the report is
lined up on the left—the
default setting of Align Left.
( t was used to indent
each paragraph.)

Single Space

Lines of text are close together, with no extra space, or leading, between lines.  This is
how text usually appears in newspapers and magazine articles.  Change this setting by
selecting another line spacing option.  See  How Line Spacing Works, next page.
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Double Space

Lines of text are separated with an extra line of space.  This is how formal papers are
often formatted, and may help some students with visual processing of text.  Change
this setting by selecting another line spacing option.  See  How Line Spacing Works,
below.

Triple Space

Lines of text are separated with two lines of space.  This option is useful when printing
drafts for peer proofreading because it leaves room for comments.  Change this setting
by selecting another line spacing option.

How Line Spacing Works

Each paragraph can have its own line spacing.

To change the current paragraph, select the line spacing option you want.  The
current paragraph will reflect the change.

To change the next paragraph, press r to start a new paragraph, then select
the spacing option you want.  Begin typing to see the change.

To change a section of your document, highlight the part(s) you want to change,
then select the line spacing option you want.

To change the entire document to the same alignment, select all (Edit menu),
then select the line spacing option you want.

Hide/Show Page Breaks

Select Show Page Breaks to show a dotted line around page margins and across the
screen at page breaks.  Use this setting to make sure your document will print the way
you desire.  Select Hide Page Breaks to view your document without these lines.

Note:  Margin and page break “lines” will not print.

Note:  When page breaks are displayed, the background color will stop at the margins
of the page, leaving a white border around the active area of the document.  When you
select Hide Page Breaks, the background color will extend throughout the entire page.

Save As Default

Select Save As Default to save the current settings of font, color, spacing, alignment,
margins, etc. to be the default settings for all new documents.  For more information
on saving file preferences and options for individual students and groups of students,
see Saving Option Settings in Chapter 6, Using Write:OutLoud in the Classroom.
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Speech Menu

Windows Macintosh

Use the Speech menu to select Write:OutLoud’s speech functions.  Write:OutLoud lets
you decide when you want the system to speak, what should be spoken and what to
repeat.  You control whether to listen to the speech while you are typing or listen later.
You decide which voice and rate you want for speech.  You also can phonetically
correct the pronunciation of selected words.

Turn Speech Off/On

Toggles all speech options off and on.  When turned off, the Speak and Repeat toolbar
buttons are not available; Speak Toolbar in the Options menu is not available.

This is useful for users who want to turn off the speech options temporarily to work
quietly, without altering their usual speech settings.

Tip:  Earphones may be a good idea in a classroom, lab setting or workplace,
eliminating outside sounds and distractions for the user as well as preventing
the computer speech from becoming distracting to others in the environment.
The same volume setting applies.

Choose Turn Speech On to have your speech settings active again.

Speak

Speak text.  Works exactly like the Speak button in the toolbar.

Write:OutLoud speaks highlighted text or, if no text is highlighted, speaks the sentence
containing the cursor.  Click Speak again and the next sentence is spoken.  With this
feature, you can move through your entire document sentence-by-sentence, speaking
each as you go.

To speak specific words or sentences, highlight the text first, then click Speak.

To speak the entire document, choose Select All in the Edit menu and click Speak.

Note:  For speaking, sentences are spoken until sentence-ending punctuation or a
paragraph break is encountered.
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Students can control reading of their document for comprehension or revision.

Repeat

Repeat last spoken text.  Works exactly like the Repeat button in the toolbar.

Students can repeat what was just heard to increase comprehension or when
proofreading their work.

Stop Speech

Click this to immediately stop the current speech.  This works exactly like the Stop
button in the toolbar.

Students can immediately interrupt speech for any reason:  to revise their work, work
quietly, end a work session, make a different selection, etc.

Speak Letters

When checked, speaks each letter as it is typed.  Choose Speak Letters to uncheck.

Turn Speak Letters on for students learning keyboarding skills and students with
physical disabilities or visual impairments to reinforce that the correct letter has been
typed or selected.

Speak Words

When checked, speaks each word as it is completed.  A word must be followed by a
space, punctuation, or a paragraph return before Write:OutLoud can speak it.  Choose
Speak Words to uncheck.

Turn Speak Words on for students with learning disabilities and poor spellers for
immediate auditory feedback that they have or have not typed the word they wanted.
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Speak Sentences

When checked, speaks each sentence as it is completed.  A sentence must be followed
by punctuation (period, exclamation point or question mark) before Write:OutLoud
will speak the sentence.  Choose Speak Sentences to uncheck.

Turn Speak Sentences on for writers to hear completed sentences, or for students
using Write:OutLoud for communication.

Speak Paragraphs

When checked, speaks each paragraph as it is completed.  Write:OutLoud identifies a
paragraph when a r or e is selected.  Choose Speak Paragraphs to
uncheck.

Turn Speak Paragraphs on for reading lists, for writers to hear completed paragraphs,
or for students using Write:OutLoud for communication.

Highlight Word by Word

When checked, individual words are highlighted as they are spoken.  Choose Highlight
Word by Word to uncheck.

Highlight Word by Word is an option that is helpful for students who are learning to
read, or for students with visual tracking difficulties, because it helps students see and
hear the word simultaneously.

Tip:  This option slows down speech feedback somewhat.  If speech seems
sluggish on your computer, use a faster computer or uncheck this option while
you work.

Voice Settings…

Opens the Voice Settings dialog.   This is where the voice, speed and speech volume
can be changed and tested.

Windows

Click the voice
you want to
use.  The voice
will be
“previewed”
at the selected
rate and
volume

Move the slide bars or type in a new
value in the Rate or Volume field to
change the value—the selected voice
will be “previewed” at the new
settings

Return to the document
with the changes

Return to the document
without the changes
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Macintosh

Tip:  Earphones may be a good idea in a classroom, lab setting or workplace,
eliminating outside sounds and distractions for the user as well as preventing
the computer speech from becoming distracting to others in the environment.
The same volume setting applies.

Pronunciations…

Opens the Dictionaries dialog.  The built-in speech does not always pronounce words
exactly as you want; abbreviations and proper names are often mispronounced.  Try
out special words and names in Write:OutLoud first.  If the pronunciation isn’t exact,
choose Pronunciations… to add these words to the pronunciation exceptions
dictionary.

Windows

Click the voice
you want to
use.  The voice
will be
“previewed” at
the selected
rate and
volume

Move the slide bars for the Rate or
Volume field to change the value—
the selected voice will be
“previewed” at the new settings

Return to the document
with the changes

Return to the document
without the changes

Add a new entry—takes you to
the Dictionary Entry dialog

Return to the
document with
the changes

Delete selected entry

Edit selected entry—takes you to
the Dictionary Entry dialog

List of special
words already
in the
pronunciation
exceptions
dictionary

Speak the Key value for the
selected entry

Speak the Translation value
for the selected entry

Speak Key field

Speak Translation field

Type in word

Type in
“phonetic”
pronunciation

Return to the Dictionaries
dialog without the changes

Return to the Dictionaries
dialog with the changes
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Macintosh

The dictionary already contains pronunciations for many common abbreviations
and proper names.  Add your own to the list whenever you encounter a
mispronounced word.

Windows Menu

Windows Macintosh

Items that appear in this menu are names of Write:OutLoud documents that are
currently open.  The one that is checked is the current document.  When you choose a
different document, it moves to the front and you may work in it.  You may have as
many documents open as your computer memory will allow.

If there are more than nine documents open and the document you want is not listed
in the menu, choose More Windows from the bottom of the Windows menu.

The Select Window dialog opens.

Highlight the document you want to work with, then click OK.

List of special
words already
in the
pronunciation
exceptions
dictionary

Type in word

Type in
“phonetic”
pronunciation

Speak current field

Return to the document without
the changes

Return to the document
with the changes

Add a new entry

Delete selected entry
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Help Menu

Windows Macintosh

On-screen Help includes a review of Write:OutLoud features and functions.  It also
includes a list of key equivalents to perform functions without using the mouse.

The first Help window has a list of topics.  Click on the topic you want to view and
information will appear on that specific menu or topic.
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Chapter 3
The Spell Checker and Dictionary

“… I think we need to seek — continually — new ways to be successful
with children and spelling.  Getting an ‘A’ on a spelling test is simply not
going to motivate some children.  Then too, some children get ‘A’s’ but
forget the words as soon as they pass the test.  Building vocabulary, I have
found, is not a kid’s goal; that’s a teacher goal.  If your want kids to be
motivated spellers you have to tie it to their life and the things they do.”

—Joe Turner
Center for Inquiry

Indianapolis, Indiana

Why Write:OutLoud’s Spell Checker and Dictionary Work

Recent educational research shows that the best way for students to learn spelling is to
link it to writing.  But students who are frustrated with their inability to recall the
spelling of the word they want to use often give up and substitute a simpler word that is
easier to spell.  Students who know a word when they hear it may not recognize it in
print.  And many students also have difficulty distinguishing between homonyms and
other “confusables.”

Write:OutLoud and the Franklin Spell Checker and Dictionary help students do just
that.  Hand-held Franklin Spell Checkers have been the teacher’s choice for students
struggling with spelling because of their ease-of-use and capability to recognize
homonyms and “phonetic” spellings of irregular words in addition to common
misspellings.  And Write:OutLoud has long been recognized as an effective tool for
struggling writers because of its simplicity and powerful speech features.

With Write:OutLoud, the integrated Franklin Spell Checker and Dictionary become
talking tools that go even further to help struggling students.  The Franklin Spell
Checker shows the word as used in context as well as possible alternate spellings.  The
student can see what they wrote and see if it is what they intended to write.
Write:OutLoud can speak and spell out the word, the contextual sentence and
suggested words to help students determine the correct spelling of the word they want.

The Franklin Dictionary also shows the word used in context and gives a brief
definition of the word in question.  It also lists homonyms and other similar words
that could be confusing to the student.  Again, Write:OutLoud can speak and spell out
the word in question, the contextual sentence, definitions and suggested words to help
students choose the word that really conveys the meaning they intend.
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Using the Franklin Spell Checker in Write:OutLoud

You can initiate the spell check function in either of two ways:

. Click the Check Spelling button in the toolbar

. Select Check Spelling from the Edit menu

Write:OutLoud always checks the entire document for spelling errors.

The Spelling Dialog

Write:OutLoud displays the Spelling dialog when it finds a word that is not in either the
regular Franklin or user dictionaries.  The general buttons in the Spelling Window let
you make changes to the document or Write:OutLoud User dictionary, which contains
personal words and names, and other words that are not contained in the standard
Franklin Dictionary.

Learn

To add the highlighted word to the WOL User Dictionary, click Learn.

Stop

At any time, click the Stop button to stop the speaking.

Next Word

If you don’t want to change the word in question, click Next Word to continue the
spell check.

Change

When the correct word is in the Change to field, click Change.  The word is replaced in
your document, and the spell checker goes on to the next word in question, if any.

Speak the
sentence and
the word in
question

When checked, words in question and suggested
words are also spelled out, letter-by-letter

Change word in question to the
word in the Change to field

Add the highlighted word to
the WOL User Dictionary

Stop speaking

Return to the document

Speak
suggested word

Continue the spell check without
changing the current word



76

Write:OutLoud®

OK

Click OK when you are done with the spell checker and want to return to the document.

Read Word Spelling

When checked, Write:OutLoud spells out words in question and suggested words,
letter-by-letter, after it speaks them.

This option is helpful because many questioned words might be spelled phonetically
(and incorrectly) by the writer.  When the word is spoken it will sound correct.
However, when the word is spelled out, it may help the writer hear the difference
between the word they typed and the correct spelling.

The Word in Question Window

The Spelling dialog displays the sentence containing the unknown or misspelled word
(highlighted) along with suggested known or correct words.  Use the spell checker to
hear the word in question spelled out and spoken in context and to hear other
suggestions in its place.  If the word in question is really a correct word or proper
name, you can add it to the WOL User Dictionary by clicking Learn.

Speak Sentence and Word in Question

To hear the sentence with the misspelled word, click the first Speak button.
Write:OutLoud speaks the entire sentence and repeats the misspelled (highlighted)
word.  If Read Word Spelling is checked, Write:OutLoud also spells out the word in
question, letter-by-letter.

The Suggested Words Window

Speak the First Suggested Word

Write:OutLoud suggests a word in the Change to field.  To hear this word spoken and
spelled, click the word to highlight it.  The word moves to the Change to field.  Click
the Speak button next to the Suggested Words.  If Read Word Spelling is checked,
Write:OutLoud also spells out the suggested word, letter-by-letter.

Speak More Suggested Words

To hear another suggested word, click the word to select it and then click the Speak
button.  Ways to select a suggested word are:

. Click the word.

. Use M until the suggested word is selected.

. Type the key equivalent (q¡, q™, etc.) that precedes the word you want.

. If there are more than five additional suggestions, use the scroll bar to view more, then
click the word you want to select.

If the correct word doesn’t appear in the suggested word list, type the correct word in
the Change to field.
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Using the Franklin Dictionary in Write:OutLoud

You can initiate the dictionary function in either of two ways:

. Click the Check Dictionary button in the toolbar

. Select Check Dictionary from the Edit menu

The Dictionary dialog opens.  In it, you can check word meanings with the Franklin
Dictionary and Homonym Checker.  Select the word or section of the document that
you want to check.  Then select Check Dictionary.

Note:  If you don’t select a word or section of your document, Write:OutLoud checks
only the word you just finished typing.

The Dictionary Dialog

Write:OutLoud displays the Franklin Dictionary and Homonym Checker with the
sentence that includes the word you are checking in the first window.  The word
meanings for the word in question are displayed in the second window and
homonyms, if any, are displayed in the third window.

Next Word

If more than one word was selected for Check Dictionary, click Next Word to continue
the spell check without changing the current word in question.

Stop

At any time, click the Stop button to stop the speaking.

Change

When the correct word is in the Change to field, click Change.  The word is replaced in
your document, and the dictionary goes on to the next word in question, if any.

Speak the
sentence and
the word in
question

When checked, words in question
and suggested words are also
spelled out, letter-by-letter

Change word in question to the
word in the Change to field

Go to the next word in question
without changing the current word

Stop speaking

Return to the document

Speak
definition(s) of
the word in the
Change to field

Speak the word
and short
definition of the
word in the
Change to field

Select another word to see its definition
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OK

When you are finished with the dictionary and want to return to the document, click
OK.  All changes are in the document.

Read Word Spelling

When checked, Write:OutLoud spells out words in question and homonyms,  letter-by-
letter, after it speaks them.

The Word in Question Window

Use the dictionary to hear the word in question spelled out and spoken in context.

Speak Sentence and Word in Question

The word in question and the sentence in which it appears is in the first window.  To
help understanding and independence, students may click the Speak button to hear the
sentence.  Write:OutLoud speaks the entire sentence and repeats the (highlighted)
word in question.  If Read Word Spelling is checked, Write:OutLoud also spells out the
word in question, letter-by-letter.

The Definition Window

You can check the meaning of the word in question by looking at the second window.
Definitions for the word in question appear there.  If there are more meanings, they
are listed also (you may have to scroll to bring them into view).  If the definition does
not match the word you want, you can consider the other words listed in the
Homonyms window.

Speak Definitions

To help with understanding and independence, students may click the Speak button to
listen to the definitions.  This feature helps students check their own work for correct
word usage.

The Homonyms Window

If the word in question has homonyms, confusing words with similar spellings or
pronunciations, they are listed in the third window.  This feature helps students
understand that there are words that sound alike.

To help understanding and independence, students may click the Speak button to
listen to the homonyms. To hear another suggested word, click the word to select it
and click speak.  Ways to select a suggested word are:

. Click the word.

. Use M until the suggested word is selected.

. Type the key equivalent (q¡, q™, q£ ) that precedes the word you want
to select.
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. If there are more than three additional suggestions, use the scroll bar to view more,
then click the word you want to select.

The selected (highlighted) homonym appears in the Change To field.  Its definition
appears in the Definition field.  If you want to replace the word in question with the
selected homonym, click Change.

When you are finished checking definitions and making changes, click OK to return to
your document.



80

Write:OutLoud®

Chapter 4
Adding Pictures to Documents

Pictures play an important role in telling stories and conveying information.  When
writers are revising their text for meaning, they might find something that is difficult to
put adequately into words.  Adding pictures is a natural way for writers to help make
their ideas clearer.

Write:OutLoud includes a number of sample pictures which are organized into
categories.  It also can import pictures from clip art collections and other locations on
your computer.  After you select and add a picture to your document, you can resize it,
change its alignment, copy or paste it in much the same way as you do text.

Add a Sample Picture

To place a picture in your Write:OutLoud document, position the cursor where you
want your picture to be.

Click Add Picture, or select Add Picture from the Edit menu.

Write:OutLoud pictures are organized by categories and kept in folders.  Double-click
or press r to open the highlighted folder/category.

The list of pictures appears.  A preview of the highlighted picture is shown next to the
list.  Use the scroll bars to view other pictures in the folder.  If you want to look in a
different folder, double-click the arrow at the top of the list to go back one level in the
Write:OutLoud Pictures folder.

Double-click a
folder or press
r to see
the list of
pictures in the
category

Picture will be added
after this point



81

Adding Pictures to Documents

When you find the picture you want, click OK.

The picture is inserted into your document.

Write:OutLoud automatically puts one blank line both before and after the picture to
set it off from the text around it.  This also makes it easy for the student to select the
picture for additional formatting.  Of course, you can delete the extra lines and even
put more than one picture on a line if you want (provided the pictures are small
enough to fit).

Double-click
arrow at the
top of the list
to go back a
level in the file
directory

Use the scroll bars
to move up and
down the list of
pictures in the
folder

Put the selected
picture into your
document

Return to the
document without
any pictures

Write:OutLoud
automatically puts
the picture in a
new paragraph,
with one blank line
before and after
the picture

After a picture
is inserted, the
cursor
advances to
the next line
for more
typing
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Add Your Own Picture

Write:OutLoud can also import graphics from other places on your computer.  Select
Add Picture.

To find other pictures, click Other in the Add Picture dialog.

Use the standard dialog directory to select a graphic from anywhere on your computer.
Use the popup menu to change the file type, if necessary.

Select a picture file and click Open.  The selected picture will be shown in the Preview
window.  If it is not the picture you wanted, click Other… to select a different picture.

Click OK to add the picture to your document.

Tip:  For ease of use, add your own pictures to Write:OutLoud’s picture
directory.  See Adding Your Own Pictures to the Pictures Directory, p. 85.

Use the popup menu to save as a different
file format

Preview of the graphic
you just selected

To add a picture that is not in the
Write:OutLoud Pictures folder,
click Other… to locate it.
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Resizing Pictures

You can also make pictures bigger or smaller.  Highlight the picture.  Then click the
Grow or Shrink Selection buttons, or choose the option you want from the Text menu.
Each time you click the Grow or Shrink Selection button, the picture will change size.

You can also resize with the mouse cursor.  To do that, click the picture so that you
see the selection box.  Place your mouse pointer over the box in the lower right corner
until your pointer changes to a double-arrowed cursor.  Macintosh users, hold the
mouse button down.  Windows users, click the right mouse button.

Drag the corner of the picture box to make the box small or larger.  Release the mouse
button.

Use the mouse to resize the
picture—drag the lower right
corner of the picture until it is
the size you want
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Changing Picture Alignment

When the picture is in your document, you can click the Alignment button to change
how the picture lines up with your text.

Or, choose the specific alignment command you want from the Options menu.

The picture above is centered in the document.

Tip:  Pictures are always inserted on their own line, with blank lines before and
after the picture.  After adding pictures, you can delete the extra blank lines and
even add text to the lines containing the pictures if you want.  You might want
to put a t or x between the picture and the text.
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Adding Your Own Pictures to the Pictures Directory

You can, of course, import pictures from anywhere on your hard drive, network or
media in your computer.  Locating files with the directory dialog may not be easy for
some students.

To make pictures easy for students to find, you may want to add them right into the
Write:OutLoud Pictures directory.  To do this:

1 Locate the pictures you want to use.

2 Make sure the graphics are in a format that Write:OutLoud can import (BMP, PICT or
JPEG—see Graphic Formats Supported, page 86, for more information).

3 Organize them into folders by subject or category.  Name the folder(s) something
unique so it is easy to remember what pictures are in them.

4 Copy or move the folder(s) into the Pictures folder within the WriteOutLoud folder.

5 Your picture folder(s) should be available in the Write:OutLoud Pictures directory
when you select Add Picture.

New folders have been dragged into the
Pictures folder in the WriteOutLoud folder

Pictures are now organized into folders

Double-click a
folder to open
it
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Graphic Formats Supported

Write:OutLoud supports pictures that are Bitmaps, PICTs or JPEGs.

Bitmaps (BMP)

BMP is the standard Windows bitmap image format on DOS and Windows-compatible
computers.

PICT

The PICT format is widely used among Macintosh graphics and page-layout
applications.

JPEG

The Joint Photographic Experts Group (JPEG) format is often used to display
photographs and other images in HTML documents over the World Wide Web and
other online services.  JPEG images can be compressed at different levels, so image
quality can vary greatly.  Most images downloaded from the Internet will be in JPEG
format.

Tip:  The Space folder in the Pictures folder contains sample JPEG photos for
you to try with Write:OutLoud.
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